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[bookmark: _Toc21589128]Introduction
[bookmark: _Toc21589129]Purpose
The purpose of the document is to familiarize users with the SRG/STIG Applicability Guide and its functions. 
[bookmark: _Toc21589130]About the SRG/STIG Applicability Guide
The SRG/STIG Applicability Guide allows users to build a collection of assets pertaining to an environment, such as an information system. Using the collection built up by the user, the tool will determine the SRGs, STIGs, and other policy documents required by the user. The tool allows users to preview and export the policy documents as well as import and export the collection.
Application Functions:
· Two modes of asset addition for different levels of familiarity
· Drag and drop of assets in the asset tree
· Drag and drop asset collection files into the asset tree
· Import and export asset collections
· Export policy documents
· Preview policy documents
[bookmark: _Toc21589131]Unpacking and Launching the Application
The SRG/STIG Applicability Guide will be downloaded in the form of a .zip file that will need to be unpacked before it can be used. Follow the steps below for the desired operating system. These steps will only need to be performed initially.
[bookmark: _Toc21589132]Windows
1. Open the .zip file provided and click “Extract all” at the top.
[image: ]





Double click the file titled “STIGApplicabilityGuide”.
[bookmark: _Toc21524698][bookmark: _Toc21589133][bookmark: _Toc21589134]Mac OS
1. Double click the downloaded .zip file. The files will be automatically extracted and it will create a new folder with the same name.
2. Open the newly created folder and double click the file titled “STIGApplicabilityGuide”.
[bookmark: _Toc21524700][bookmark: _Toc21589135][bookmark: _Toc21589136]Linux
1. Open the .zip file provided and click “Extract” on the top left.
[image: ]





Create a new folder and give it a name.
[image: ]






2. Open the newly created folder, and then navigate to Files >> Preferences at the top left.
[image: ]








3. Click on the “Behavior” tab and under “Executable Text Files”, select “Run them”, and then close the window.
[image: ]









4. Double click the file titled “STIGApplicabilityGuide” to open it.
[bookmark: _Toc534900674][bookmark: _Toc21589137]Menu Bar
[bookmark: _Toc21589138]File Menu
[image: ]The File Menu allows you to open, save, export, and create new asset collections.

[bookmark: _Toc21589139]View Menu
[image: ]The View menu allows users to preview the current list of policy documents that apply to their asset posture. As more items are added to the tree, more items will show in the Document List. 

[bookmark: _Toc21589140]Help Menu
The Help Menu contains information about the application, including the version number and a list of the applications dependencies and their licenses, and offers the ability to check for the latest version of the application.
[image: ]






[bookmark: _Toc21589141]Asset Tree
[bookmark: _Toc21589142]Overview
[image: ]The portion of the application under the file menu to the left is the Asset Tree. Here you will be able to see your current collection as well as add, edit, or remove assets. The pane to the right side is the where users are prompted and details of the application are selected. 

[image: ]
1. [image: ]To begin adding assets, navigate to the menu bar and select File >> New Collection. An item will be added to the asset tree on the left. The first Item represents the asset collection. Name it accordingly or leave it blank to keep the name asset collection.

[bookmark: _Toc21589143] Adding Assets (Standard Mode)
1. [image: ]Click the “+” button to add your first Asset. 

2. After clicking the “+” button a selection pane will appear to the right. Here you can select the asset type (top right) that applies to this asset. You will be able to see descriptions for each asset type as well as select the most fitting label* or labels (bottom left of the right pane) that apply to your asset type. 
[image: ] Press submit to create an item on the asset tree representing that item.
[image: ]
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Notes: 
· Selecting multiple labels (with checkboxes) will create multiple assets with the different labels selected.
· *Asset Label: a descriptive tag that applies to an asset.
[bookmark: _Toc21524709][bookmark: _Toc21589144][bookmark: _Toc21589145]Adding Assets (Guide Mode)
1. [image: ]Click the purple steering wheel next to the “+” button to begin Guide Mode.

2. [image: ]After clicking the Guide Mode button, a pane will appear to the right prompting you to add an asset.

3. [image: ]Select “No" to go to the next asset in the list. Select “Yes” to go to the label pane where you will select a label (if available) and/or name the asset type.

4. After adding and submitting an asset you will descend into its children, so the next prompt will be the first child of the asset you just added. Once you have decided on whether to add each child you will be returned to the top level where you will continue to add other assets. This continues until you have gone through every asset type available. 

	[image: ]

	[image: ]

	[image: ]



Notes: 
· Selecting multiple labels (with checkboxes) will create multiple tree items with the different labels selected.
·  To leave Guide Mode click “End Guide”.

[bookmark: _Toc21589146]Adding Parent Assets
If you have an asset created and would like to go in reverse order and add a parent to it, you can do so using the “Add Parent” feature. Please note that the “Add Parent” feature will only be available if the selected asset and it’s current parent have matching assets.
[image: ]Right click the asset to which you would like to add, and then select “Add Parent”.

[image: ]On the right, is the list of assets available based off of the asset you selected and it’s current parent.

[image: ]Select the asset you wish to add and click Submit. The new parent will now be added to your asset.

[bookmark: _Toc21524712][bookmark: _Toc21589147][bookmark: _Toc21524713][bookmark: _Toc21589148][bookmark: _Toc21524714][bookmark: _Toc21589149][bookmark: _Toc21524715][bookmark: _Toc21589150][bookmark: _Toc21524716][bookmark: _Toc21589151][bookmark: _Toc21589152]Editing Assets
After creating an asset, you can edit the asset using the green pencil icon on the tree item for that asset. 
1. [image: ]Click the green pencil icon to begin editing an asset. A pane will appear on the right side with the current information of the asset. 

2. Here you can change the name of the asset, and the label (if available). After making the required changes, press sumit to see the changesreflected on the tree to the left. 
[image: ]
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[bookmark: _Toc21524718][bookmark: _Toc21589153][bookmark: _Toc21524719][bookmark: _Toc21589154][bookmark: _Toc21524720][bookmark: _Toc21589155][bookmark: _Toc21524721][bookmark: _Toc21589156][bookmark: _Toc21524722][bookmark: _Toc21589157][bookmark: _Toc21524723][bookmark: _Toc21589158][bookmark: _Toc21524724][bookmark: _Toc21589159][bookmark: _Toc21524725][bookmark: _Toc21589160][bookmark: _Toc21524726][bookmark: _Toc21589161][bookmark: _Toc21524727][bookmark: _Toc21589162][bookmark: _Toc21524728][bookmark: _Toc21589163][bookmark: _Toc21524729][bookmark: _Toc21589164][bookmark: _Toc21589165]Removing Assets
1. [image: ]To remove an asset, click the “x” on the tree item for that asset. 

2. After Clicking the “x”, a prompt will pop up asking if you wish to continue with deletion. Click “OK” or press “ENTER” to delete the Asset,or click“Cancel”, press “ESC”, or click the “X” on the top right to cancel deletion.

[image: ]


[image: ]
[bookmark: _Toc21589166]Save, Open, and Merge
[bookmark: _Toc21589167]Overview
[image: ]When an asset posture has been built, the application allows users to save the Collection as an XML document and later import it again. These options can be found under the file menu. 

[bookmark: _Toc21589168] Save Collection
1. [image: ]To save a collection, select File >> Save Collection As… or click File >> Save in the menu bar. 

2. [image: ]A window will pop up allowing you to choose a save location as well as a file name. Press Save to save the collection.
[bookmark: _Toc21589169]Open Collection
1. [image: ]To open an Asset Collection select File >> Open Collection… in the menu bar.

2. [image: ]Navigate to the location of your saved Asset Collection document, select it, and then click open.

3. Your asset collection will be opened but collapsed.

[image: ]

[bookmark: _Toc21589170]Merge Collection
Merging an asset collection allows you to import assets from an asset collection file into the currently open collection. When the merge operation is successful the assets of the merged collection will be appended to the end of the current collection. If there are currently no assets in the asset tree, all elements of the merged collection (including the top level asset) will be added to the asset tree without setting the save file.
1. [image: ] To merge an Asset Collection, select File >> Merge Collection… in the menu bar.

2. [image: ]Navigate to the location of your saved Asset Collection document, select it, and click open. 

Merging Collections with tree empty:
	[image: ]
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Merging Collections with tree not empty:
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Merging Collections with save file loaded:
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[bookmark: _Toc21589171]Drag and Drop
[bookmark: _Toc21589172]Overview
The SRG/STIG Applicability Guide is drag and drop enabled, meaning you can drag and drop a compatible asset into another asset. In addition, you may drag and drop a saved asset collection file to load it.
[bookmark: _Toc21524738][bookmark: _Toc21589173][bookmark: _Toc21589174]Drag and Drop Assets
1. To drag and drop an asset, left click and hold with the mouse, then drag it to the intended asset. When the dragged asset encounters a compatible asset, the compatible asset will turn green, otherwise it will be red. Incompatible Item Dragged
Compatible Item Dragged


[bookmark: _Toc21589175]Drag and Drop Files
1. To open a file via drag and drop, drag the file over to the area of the asset tree and drop it. Valid files will either be opened (if tree is empty) or merged otherwise.
Invalid File Dragged

[image: ]Valid File Dragged
File Warning (valid file type, invalid contents)




[bookmark: _Toc6554105][bookmark: _Toc13213957][bookmark: _Toc13223155][bookmark: _Toc13223284][bookmark: _Toc13223323][bookmark: _Toc13223362][bookmark: _Toc13224028][bookmark: _Toc13224766][bookmark: _Toc13224848][bookmark: _Toc13224920][bookmark: _Toc13227084][bookmark: _Toc13227199][bookmark: _Toc13227232][bookmark: _Toc13227650][bookmark: _Toc13496091][bookmark: _Toc13496145][bookmark: _Toc13814117][bookmark: _Toc13223156][bookmark: _Toc13223285][bookmark: _Toc21589176]Exports
[bookmark: _Toc13223286][bookmark: _Toc21589177]Overview
After building an asset collection, users can export the requirements/policy documents using options in the File menu. Exports come in two file types, HTML, and Text, and in two varieties, normal/flat and asset-based list. The flat list contains the policy documents and associated information, while the asset-based list contains the asset and the path to get to that asset. 

	[image: ]
	[image: ]


[bookmark: _Toc6318678][bookmark: _Toc6554108][bookmark: _Toc13213960][bookmark: _Toc13223158][bookmark: _Toc13223287][bookmark: _Toc13223326][bookmark: _Toc13223365][bookmark: _Toc13224031][bookmark: _Toc13224769][bookmark: _Toc13224851][bookmark: _Toc13224923][bookmark: _Toc13227087][bookmark: _Toc13227202][bookmark: _Toc13227235][bookmark: _Toc13227653][bookmark: _Toc13496094][bookmark: _Toc13496148][bookmark: _Toc13814120][bookmark: _Toc13223288][bookmark: _Toc21589178] Preview
1. [image: ]To see a preview of your current collection, select View >> Document List… in the menu. A window will pop up with a list of the Requirements/Policy Documents that apply to the current asset posture. 
[bookmark: _Toc13223289][bookmark: _Toc21589179]Exporting
1. [image: ]To export as text, select File >> Export Assets (or Requirements Document) >> Export … in the menu.

2. [image: ]In the window that pops up, choose the location and name of the export file to which to save. Click save. 
	
3. [image: ]Examples:

[image: ]

[image: ][image: ]
[bookmark: _Toc21589180]Example
[bookmark: _Toc21589181]Scenario
You are tasked with securing a system on a VMWare-based cloud environment. The VM is running Windows 10 and has several applications installed including JRE 8, Microsoft Office 2016, Dot Net Framework 4.0, and an HBSS Agent. To secure this system, you need to know what policy documents to follow, and with that in mind, you turn to the SRG/STIG Applicability Guide. 

1. [image: ]Add a new Collection and name it accordingly.

2. Add a Cloud Service Asset (for this scenario we will be using Guide Mode).
	[bookmark: _Hlk535999489][image: ]
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3. Add a VM (you will have to say no to a few prompts before being prompted to add a VM). 
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4. Add the Windows 10 OS.
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5. Add the necessary applications (JRE 8, MS Office 2016, .Net Framework 4.0, HBSS Agent). 
	[image: ]

	[image: ]

	[image: ]



Note: You can check multiple items at once on the application page.

6. [image: ]Now that you have finished building up your collection, you can go on to preview the policy documents by navigating to View >> Document List….

7. [image: ]To save your collection navigate to File >> Save Collection As….

8. [image: ]Next, navigate to File >> Export Requirements Document >> Export Requirements Document As HTML… and choose an appropriate name and location, then save the document. 

9. [image: ]The exported document should look like this:
8
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